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February 24, 2006 
 
Welcome to Advanced Techniques for Equation Editor and MathType Users.  
 
This session is designed to help you get the most out of Equation Editor and MathType by 
showing you how to use them more effectively with word processors, presentation software, 
and web page editing software. We will assume you are familiar with using these tools to 
create basic documents, and our time today will be spent learning some advanced 
techniques for using these products. 
 
MathType works very well with most word processors,  presentation software (such as 
PowerPoint and Corel Presentations), web page-authoring software (such as FrontPage or 
Dreamweaver), but during the session today, we will limit the discussion to using 
MathType with Microsoft products. 
 
Hopefully, many of your needs will be addressed in this session but if you need help in the 
future, the following sources are available: 
 

 Equation Editor Tips & Tricks -- The MathType web site, http://www.dessci.com, 
includes Equation Editor Tips & Tricks to help get the most out of Equation Editor, but 
there are several tips appropriate for MathType users as well. Your email address will 
be your password to access the page immediately.  

 Help File – Both products have extensive help files.  
 User Manual – MathType comes with a comprehensive User Manual, and many 

questions can be answered by referring to this manual. Chapter 4 of the MathType 
User manual includes 18 step-by-step tutorials to get you started. 

 Technical Support – We provide lifetime technical support for MathType. For 
technical support: 

 Phone: 562-432-2920 
 Email: support@dessci.com 
 Web: http://www.dessci.com (click one of the Support links). A collection of 

“support notices” at the site covers most topics for both Equation Editor and 
MathType.  

 
 
 
 
Bob Mathews 
Director of Training 
bobm@dessci.com
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1. Creating an icon in Microsoft Word that inserts an equation 
MathType already creates toolbar icons to click and launch MathType, but Equation Editor does 
not. Most users insert Equation Editor equations by choosing the Object command on the Insert 
menu. You then see a list of objects you can insert into your document, and double-clicking on 
“Microsoft Equation 3.0” launches Equation Editor. There is an easier way! You can add an icon 
to Word’s toolbar which inserts a new equation into your document with a single click! 
 
Just follow these steps to add an Equation Editor icon to Word's toolbar: 
 
1. To add the icon, choose the Customize command on the Tools menu to display the 

Customize dialog. 
2. Click on the Commands tab to display the list of commands. 
3. You will see a list of Categories on the left and a list of Commands on the right. On the left, 

click on “Insert.” On the right, scroll down and near the bottom of the list will be this 
button: . Click on this button and drag it to the toolbar, placing it wherever you want it. 

4. Click “Close” on the “Customize” dialog. That’s all there is to it! 
 
By the way, this procedure also works in PowerPoint. 

 

2. Changing Word defaults for menus & drawings (Windows) 
A couple of aggravating features of Word 2002 + (Office XP +) are related to the Word menus 
and creating drawings with the drawing toolbar. 
 
1. The default is for Word’s menus to show only basic commands 

after you first install Office. As you work, the menus adjust to 
show only the items you’ve used most recently. If you wait a 
couple of seconds, the full menu appears. If you don’t want to 
wait, you can click the double chevron at the bottom of the menu. 

2. To change this behavior to always show the full menus, click on 
Tools > Customize. On the Options tab, check the box next to 
“Always show full menus”. 

3. The default for using the 
“AutoShapes” on the Drawing 
toolbar is for Word to create a 
“Drawing Canvas”, into which 
you’ll insert your drawings. If you 
don’t want the Drawing Canvas, 
you can change the default. 

4. Click on Tolls > Options, and 
click on the General tab. Near the 
bottom of the tab, uncheck the 
box labeled “Automatically create drawing canvas when inserting AutoShapes”. 
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3. Status bars & Equation Editor menus 
Status bar 
When you’re using an application, normally the bottom of the window is called the “Status bar”, 
as you can see below. This is true in both Windows apps and Macintosh apps. 

(Windows) 

(Macintosh) 

 
The status bar is especially useful when using Equation Editor and MathType. We’ll discuss 
Equation Editor here, and deal with MathType in a later section. 
 
When you have Equation Editor open and you point the mouse pointer at a palette, a symbol, or a 
template, the status bar gives you a description of the item. Examples: 
 

 
 

 

These are 
Equation Editor 
menus, not 
Word menus. 
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Menus (Windows only) 

The Windows version of Equation Editor opens up in what we call “in-place editing”. This is 
indicated by diagonal lines within the document showing where the equation will be placed. All 
editing is done within the area defined by these diagonal lines. (See screen shot above.) Equation 
Editor’s menus are not located above the toolbar. Rather, they are located on the Word menu bar, 
where Word’s menus would normally be located. 
 
If you would rather have Equation Editor open in a separate window (as shown in the Mac 
screen shot above), rather than opening up to in-place editing, refer to our “Equation Editor Tips 
& Techniques” document on our web site (mentioned in page 2 of this handout). Tip #3 
discusses this. 

 

4. Nudging and the MathType Customizable Toolbars 
Nudging is a technique that can be accomplished in both Equation Editor and MathType, and 
is very useful in achieving perfect positioning for your equations. 
 
1. For example, let’s say you’d like more space between an integral symbol and the limits of 

integration. We’ll add more space by nudging the limits to the right. 
 

2. Select the upper limit. The most common method to select items is to drag the mouse across 
the item. For small items though, such as limits, subscripts, etc., it’s easier to use the Shift 
and arrow keys. With the cursor to either the left or right of the item you want to select, hold 
down the Shift key as you press the either the left or right arrow key, as appropriate. Release 
the Shift key after you’ve completed the selection. 
 

3. Hold down the Ctrl key. Use the arrows on the keyboard to move the selected item(s) in the 
desired direction.  
 

( )∫
∞

0
dxxf  ( )∫

∞

0
dxxf  

before nudging after nudging 

 Note that not all printers will print the limits as tightly-spaced as the ones in the “before” 
example. You may have to experiment with nudging a bit in order to find the peoper amount. 

 
If you’re using MathType, you can save the newly-nudged expression or equation to the toolbar. 
That way you don’t have to nudge it every time you use it: 
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5. Keyboard Shortcuts 
MathType was designed with a “point and click” interface. Find the symbol or template you need, click on it, and it 
becomes part of your equation. The program also has many keyboard shortcuts, so you can access the commonly-
used symbols and templates without having to take your fingers off the keyboard. 

The keyboard shortcuts built in to MathType are listed in the Help file. You’ll find though, that most of the shortcuts 
are so intuitive that you can learn them quickly, and be able to use the software even more efficiently to create 
professional-looking documents. 

Many of the shortcuts used in MathType are “standard” shortcuts – such as CTRL+S for save, CTRL+C for copy, 
CTRL+V for paste, etc. (On the Mac, substitute the COMMAND key for the CTRL key.) Listed here are some of the 
most commonly-used keyboard shortcuts: 
 

Text mode ..................................................... CTRL+E 
Math mode .................................................... CTRL+= 
Greek letters .................................................. CTRL+G, followed by corresponding   
...................................................................... letter of the alphabet (a for α, etc.) 

“Expanding” parentheses .............................. CTRL+9 
Full-sized fraction template........................... CTRL+F 
Radical (square root)..................................... CTRL+R 
Superscript (exponent) .................................. CTRL+H (“h” for “high”) 
Subscript ....................................................... CTRL+L (“ A ” for “low”) 
Thin space ..................................................... CTRL+SPACE 

 
For more keyboard shortcuts, you can refer to 

• “Customize Keyboard” in the MathType Preferences menu 
• The MathType Help file under “MathType Reference/Keyboard Shortcuts.” 
• The Equation Editor Help file: “Reference Information/Keyboard Guide.”  

 
Also note that in MathType, when you point to an item with the mouse, the description and keyboard shortcut are 
displayed in the Status Bar: 
 

MathType displays description and 
keyboard shortcut information in 
the status bar. Equation Editor 
displays only the description. 
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6. Creating a blank grid for student graphing 
One of the most common questions we get is “Does MathType make graphs?” I always give a 
“qualified” answer to that question – No, MathType won’t graph a function, but you can make a 
blank grid for students to do the graphing. Note: There is a more detailed procedure for graphs 
and number lines on our web site. You can access this tutorial at 

www.dessci.com/en/support/tutorials/mt_charts/tutorial.htm 

(This will be done using Equation Editor. If you are using MathType, the steps are similar.) 

a. In a Microsoft Word (the procedure may be adapted for other software), open Equation 
Editor From the Insert menu, and select Object. From the list, choose “Microsoft 
Equation”, and click OK. 

b. On the Matrix templates palette, select Variable-size matrix or table. 
 
 
You can look at the “Status Bar” – the very bottom of the Word or MathType window – to 
see what it is you’re pointing to: 
 

c. In the Matrix dialog, specify the size you want. You probably want 
a larger one than 6×6, but we’ll use this size as an example. The 
maximum size is 30×30, so if your axes will be in the center, that’s 
±15 on both axes. Notice the comment at the bottom of the dialog: 
“Click between elements to add/change partition lines.” 

d. There are 4 types of lines: no line (the default), solid line, dashed 
line, and dotted line. You select the type of line by continuing to 
click in the same location (twice for dashed, etc.). If you put solid 

axes in the center of the 
grid, and dotted lines 
everywhere else, the screenshot to the left is what the 
dialog would look like when you’re through. Below 
is what the grid looks like in your finished test, quiz, 
or whatever (these are dotted lines except the axes). 

In MathType, the column and 
row specifications are in a 
different place, and there is a 
“Clear all lines” button, which is 
handy. You can also save the 
grid on the MathType toolbar, 
which you can’t do in Equation 
Editor. 
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7. Aligning items within an equation 
There are all sorts of things to align within an equation – the work shown below a dividend in a 
long division problem, equations in a system of equations, items in a pictogram, responses in a 
multiple-choice question, etc. We will look at two of these: systems and multiple-choice. Note: 
Even if you don’t teach the level of math requiring systems of equations, and even if you never 
create multiple-choice tests, the techniques learned here will still be useful to you. 

Systems of equations and inequalities 

a. There is no right or wrong way to “align” the equations in a system; it’s basically a matter of 
choice, and a matter of what your students can read the best. (For simplicity, we won’t 
specifically mention systems of inequalities, but these exact steps will work for those as 
well.) Here are 4 different scenarios: 

3 4 17 3 3
5 3 6

2 3 2 15 2 3 2 3
2 7 2

4 3 2 3 3 2 3

x y z x x
x y

x y z x y x y
x y

x y x y z x y z

+ + = = =⎧ ⎧ ⎧
− =⎧ ⎪ ⎪ ⎪+ + = + = + =⎨ ⎨ ⎨ ⎨+ =⎩ ⎪ ⎪ ⎪+ = + + = + + =⎩ ⎩ ⎩+

1 2 3 4

 

b. Systems 2 and 3 above present the greatest challenge, so let’s deal with system 2. 

c. In this system, we want to align the variables, the operation symbols (+, −, or =), and the 
sums so that they are vertically aligned with similar elements in the previous equation, and 
right-justified within each column (for example, z & 2z and 15 & 4 in system 2 above). 

d. There are many ways to align a system, but let’s just cut to the chase and say that using a 
matrix is the best way to do it. So, that established, what size? The obvious number of rows 
is a number equal to the number of equations. There are several choices for the number of 
columns, but the best balance between utility and ease of use is a number of columns equal to 
the number of equations plus one. So our matrix for system 2 above will be a 3×4. 

e. The first step is to insert the Left brace from the Fences palette on the Equation Editor or 
MathType toolbar. The icon you’re looking for on the Fences palette is this one:        . (It’s 
in column 1, 4th from the bottom.) 

f. Next insert a 3×4 matrix by selecting “Variable-size matrix” from the Matrix templates 
palette, making sure to select Column align: Right in the Matrix dialog. 

g. Now you’re ready to insert the equations into the matrix, but how you do it is critical! Enter 
3x + in the first cell, press Tab to go to the next cell, enter 4y +, press Tab, enter z =, press 
Tab, and enter 17 in the last cell. Pressing Tab once more gets you 
down to the next row to begin entering the second equation. Enter 
the next 2 equations similarly. This is how it should look when 
you’re done (doesn’t look very pretty, does it?): 

3 4 17
2 3 2 15

4

x y z
x y z
x y

+ + =⎧
⎪ + + =⎨
⎪ + =⎩ +

So, how do you get the right amount of space where the “+” should be? In Equation 
Editor, your only choice is to add spaces. Problem is, 3 isn’t enough and 4 is too many. In 
MathType, there’s a more elegant (and more exact) way: insert a +, then color it  white  ! 
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h. One more step, then we’re done. There’s a simple adjustment that lets us move the columns 
of the matrix closer together. On the Format menu, select Define Spacing. The third item 
from the top is what you want to adjust: Matrix column spacing. The normal setting is 
100%. Since we want to decrease the spacing, we want a number smaller than 100%. (If the 
dialog is in the way and you can’t see your equations, place the mouse pointer on the title bar 
of the Spacing dialog and drag it away from your matrix so that you can see your entire 
system.) Try a spacing value of 50%, but don’t click OK yet. Watch your system of equations 
as you click Apply. If you like the results, click OK; if you need to decrease the spacing 
further, try a smaller number. (It’s easy to see how valuable the Apply button is. It’s a real 
time saver when compared to repetitively clicking OK each time, because once you click OK 
the dialog disappears. Also, it’s important that the percent symbol is selected in the drop-
down box. You sure don’t want a spacing of 50 points or 50 inches!) 

i. After you settle on a value (my personal opinion is that 25% works best), either click in your 
document to close the Equation Editor window and go back to Word, or if you’re using 
MathType, simply close the MathType window (click the × in the upper right-hand corner). 

j. In MathType, you have two attractive options you don’t have in Equation Editor: 

 You can save the matrix spacing to a preference file. This is a good idea, because you 
won’t want to use this tight matrix column spacing in a “regular” matrix, and this will 
give you an easy way to change back to your “systems of equations” settings. A 
MathType preference file holds information on fonts, sizes, and spacing. To save the 
preference file, go to the Preferences menu, scroll down to Equation Preferences, then 
choose Save to File. You can name the file anything you want, but here are some 
suggestions: Systems (if you always use the same font and size for your tests & 
quizzes); Systems-TNR, Systems-A, etc. (for tests written in Times New Roman, Arial, 
etc. font); Systems-A-10, Systems-A-12, etc. (for tests written in Arial 10pt, Arial 12pt, 
etc.). You get the picture. 

 You can save a blank template for a 2-equation system, one for a 3-equation system, etc. 
to your MathType toolbar. The easiest way to do this is to delete everything out of the 
cells of the matrix in the system you just created, then highlight everything and drag it up 
to the toolbar: 
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Multiple-choice responses 

a. There are many ways to type multiple choice responses for a test or quiz. You may create 
each choice as a separate equation (remember, we use the word “equation” to denote 
anything created with Equation Editor or MathType, regardless of whether or not it contains 
an equal symbol), or you could include all the responses in a single equation and arrange 
them in various ways. Two common ways to arrange the responses are to place them all on 
the same line of text or to put two responses on one line and two on another line. We’ll deal 
with the first option here. 

b. For this example, we’ll create the responses for this question: 
 
 1. Find the quotient: ÷2 1

3 21 1  
 
  3 1 1

5 2 9a.  2 b.  2 c.  1 d.  2  

c. One option would be to type the question and all the responses as a single equation, but we’ll 
type the question text in Word and the division expression and responses in Equation Editor 
or MathType. We’ll type all 4 responses as one object. 

d. Assuming you’ve already typed the question, let’s work on the responses. Open Equation 
Editor as you normally would, either from the Insert menu or by clicking the icon on your 
Word toolbar. (This will be specifically Equation Editor. These steps will work, of course, in 
MathType as well, but there will be separate steps for MathType later.) 

e. We’re using Arial font and 11pt size, so adjust your Style and Size accordingly. If you don’t 
know how to do that, see the Equation Editor Help file, and look under “Applying Styles and 
Fonts in an equation | Change an Equation Editor style” and “Changing Mathematical 
Element Sizes in Equations | Change the definition of a mathematical element size in an 
equation”. Notice especially the Tip at the bottom of the discussion on size. The Tip doesn’t 
suggest what sizes to use, but I recommend 75% for Subscript/Superscript, and 50%, 
150%, and 100% for the next 3. 

f. We want to space the responses uniformly, and the best way to do that is to use a matrix. 
This will be a 1-row, 4-column matrix, so go ahead and insert one of those in your document. 

g. Change to Text style, then type the letter a followed by two spaces. (Notice the 
space bar works just fine in Text style.) Change to Math style, then type 3

52 . When 
you type the fraction, be sure to use the Reduced-size vertical fraction, which is 
the one in the upper-right of the Fraction and radical templates palette. 

h. An easy way to keep from switching from Text to Math four times is to copy what you just 
typed (i.e., select the contents of the first cell with your mouse, then press Ctrl+C to copy). 
Now press Tab to go to the next cell, and paste the contents into that cell (Ctrl+V is the 
shortcut). Do the same with the remaining 2 cells, then edit the contents so that it looks 
similar to the above example. We’ll adjust the spacing in the next step. 
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i. Since this is a matrix, and you already know how to adjust the column spacing in a matrix, go 
ahead and adjust it to see what looks best. (I think somewhere in the range of 300-400% 
looks best, but that’s just my opinion. Use whatever setting you like.) 

j. In MathType, you have another tool that makes it even easier to create multiple-choice 
responses, and easier to keep the spacing uniform from one question to the other. If you’re 
using MathType, click on the View menu and make sure there’s a checkmark by Ruler.  

k. Notice above the ruler there are 5 arrows. These arrows represent 5 types of tabs that are 
available in MathType. From left to right, these are: 

1) Left-justified tab. This is the one selected in the screenshot below, and is the default. 
When you use a left-justified tab, the left edge of the text will be aligned at the tab. 

2) Center-justified tab. The center of the text is aligned at the tab stop. 

3) Right-justified tab. The right edge of the text is aligned at the tab stop. 

4) Relational tab. Use this tab only with more than one line of characters within your 
equation. This will align equations or inequalities at any relational operator, such as ≠, ≥, 
≡ , ∝ , and of course =. (Basically, it will align on the equal, greater than, or less than 
signs from the keyboard, plus anything on the Relational symbols palette.) 

5) Decimal tab. Use this one also for more than one line of characters. This is for aligning a 
column of numbers, regardless of whether or not a decimal point is present. 

 

l. To set a tab stop, simply click on the ruler below the number or tick-mark where you want 
the tab to be. Caution: Each template slot has its own set of tabs, so if you are inside a 
numerator slot (for example), and set a tab at the 1” mark, that tab will not be set outside the 
fraction! In the example above, make sure your “insertion point” (i.e., cursor) is outside the 
fraction before you set the tab. You won’t run into this problem if you set your tabs prior to 
typing the MathType equation, but you won’t always know where you want the tabs set 
before you start typing. Just be aware of this feature of tabs. 

m. For our example, since we’re using tabs to align the multiple-choice responses, we don’t 
need our 1×4 matrix. You can use the matrix if you want, of course, but you wouldn’t use 
both a matrix and tabs. 

n. One final point on tabs. You already know what the Tab key’s for when you’re typing in 
MathType; it’s to move from one template slot to another, or to move out of the template. To 
move to the next tab stop, you need to press the Ctrl+Tab keystroke combination. 
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8. Using Word’s AutoCorrect Feature 
Some things you create with Equation Editor or MathType are repetitive – the grid discussed 
earlier, for example. If you’re creating a worksheet on graphing linear functions, you’ll quite 
likely have 10 or 20 of these, so it’s very useful to be able to insert a grid with just a few 
keystrokes – and without even opening up MathType! 

Note: There is a more detailed tutorial on our web site for using Word’s AutoCorrect and 
AutoText features. You can access this tutorial at 

www.dessci.com/en/support/tutorials/autocorrect/tutorial.htm 

(This will be done using Equation Editor. If you are using MathType, the steps are similar. Since 
much of what we’ve done in this session has been done with Equation Editor, you may wonder 
what’s so different about MathType? There’s a page later in the handout that discusses this.) 

Setting up AutoCorrect to Insert Equation Objects 

a. For the purpose of this mini-tutorial, we’ll 
use the grid created earlier. Insert the 6-
by-6 grid into your document: 

 

b. If it doesn’t appear to be perfectly square, 
you can make it square by clicking on it 
with your right mouse button, then 
selecting Format Object from the menu. 
If Format Object doesn’t appear on the 
right-click menu, select Object from 
Word’s Format menu. 
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c. Adjust the height and width to the same 
number – whatever you want them to be. 
Make sure the Lock aspect ratio box is 
unchecked! 

 

d. Regardless of whether you re-sized your 
grid or not, make sure it’s still selected (as 
the one is to the right). If it’s not selected, 
click once on it with your left mouse 
button. 

 

e. With the grid selected, choose 
AutoCorrect Options from Word’s 
Tools menu. (If you’re using a version of 
Word earlier than Word 2002 – the one 
that comes with Office XP – it will just 
say AutoCorrect.) 

f. Note the grid is already in the box 
underneath the word With:. If it’s not 
there, then you didn’t have it selected in 
step d above. Go back and repeat steps d 
& e. (You must do it this way; you can’t 
copy the grid and paste it into the box.) 

g. In the Replace box, type in whatever code you want to enter in Word to be replaced with the 
grid. More on this later, but I chose a shortcut I could remember: “gr” for “grid”, “6” 
meaning “6-by-6”, and “a”, meaning it has axes. 

h. Click Add, then click OK. 

i. Now that you’re back in your document, delete the grid and try your AutoCorrect entry. Type 
gr6a (or whatever code you entered, followed by the spacebar. Your code should be replaced 
with a grid! 
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Now, a couple of notes about what we just did: 

1. I had you hit the spacebar after the code, but there’s nothing magical about the spacebar. The 
important thing is that you tell Word that you’re through typing that word, and in this case, 
our word was gr6a. Think about what normally “terminates” a word – a space character, any 
punctuation character, a Tab, or a new line. In fact, any of these things will replace your code 
with your grid (or whatever you entered into the AutoCorrect box). 

2. The code I chose – gr6a – may seem a little cryptic to you, and you may not think you can 
remember that one. That’s fine; choose whatever code you’ll remember, but be careful! You 
don’t want to choose a word that will likely come up in any document. The words “grid” or 
“graph”, for example, appear often, so you don’t want to choose these. I can guarantee the 
code I chose will never come up in any document ever – unless I want a 6-by-6 grid. 

3. What other uses for AutoCorrect can you think of?  I can think of several: 
 

sq2 for 2  

2p/3 for 2
3
π  qu or qform for 

2 4
2

b b ac
a

− ± −  

1/8 for 1
8 , etc. 

limx0 for 
0

lim
x→

 
imat3 or simply i3 for 

1 0 0
0 1 0
0 0 1

⎡ ⎤
⎢ ⎥
⎢ ⎥
⎢ ⎥⎣ ⎦

 

u238 for 238
92 U gr-th for θ , etc. 

xbar for x   

 …and so on. 

4. You can use AutoCorrect for even more complex objects than the ones we’ve used, but that’s 
really a subject to deal with elsewhere – like in the tutorial I mentioned that’s available on 
our web site! 
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If you have MathType, see if you can duplicate the equations below. If you don’t have MathType, this would 
be a good opportunity to download the evaluation version from the Design Science web site. 

Other uses of MathType that go “beyond the basics”… 
1. Systems of equations. 

 
3 4 17 3 3

5 3 6
2 3 2 15 2 3 2 3

2 7 2
4 3 2 3 3 2 3

x y z x x
x y

x y z x y x y
x y

x y x y z x y z

+ + = = =⎧ ⎧ ⎧
− =⎧ ⎪ ⎪ ⎪+ + = + = + =⎨ ⎨ ⎨ ⎨+ =⎩ ⎪ ⎪ ⎪+ = + + = + + =⎩ ⎩ ⎩+

 

 
2. Dimensional analysis. 

 
30 miV =

h
5280 ft
1 mi

⋅
1 h

⋅
60 min

1 min
⋅
60 sec

44ft sec=

 

 
3. Step-by-step examples with comments. 

 
( )
( )

00

0.21

.021

0.21

160; 68 ; 212 ; and 0.21

160 68 212 68
92 144

92
212

ln 92 ln144 0.21
ln 92 ln144

0.2

f r

rt
f r r

t

t

t

T T rTT T T T e

e
e

e

t

−

−

−

−

= = ° = ° == + −

= + −
=

=

− = −
−

−

Isolate the exponential expression.

Take the natural logarithm of both sides.

1
2.13345106

t

t

=

=

Calculation - ready form

 

 
4. Equations for Web pages. 

 
5. Animated graphics for PowerPoint presentations or Web pages. 

 
6. Chemistry notation. 

 
3 2 4 3 3 2 4 3

Solution Solution Precipitate Solution

Ba(NO ) (aq) 2 NH IO (aq) Ba(IO ) (s) 2 NH NO (aq)+ → +���	��
 ���	��
 ��	�
 ���	��
  

Atomic Bonding
orbitals orbital

2p 2p2s 1s 2s

F H F H

↑↓ ↑↓ ↑↓ ↑ + ↓ ⎯⎯→ ↑↓ ↑↓ ↑↓ ↑↓
i i i i

i i i i
i i


������

���	��

: : 

 

This is a good 
use of User 1 
and User 2 
styles and sizes 
(MathType 
only). This lets 
you use your 
normal font & 
size for the 
problem & 
solution, and a 
separate font 
& size for the 
notes. 
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What else can I do with MathType that I can’t do with 
Equation Editor? 

1. MathType includes over 200 symbols and templates that are not included in Equation Editor. 
Some of these are shown here. (Many of these are currently available only in the Windows 
version.) a bExamples: †≈� � ∼ : 1 U R \ ( ) &  

In addition, MathType 5 includes the ability to include a tilde, hat, arc, or harpoon (vector 
barb) over more than one character. It also includes cross-out templates for showing 
cancellation. qExamples: inchesAB  
 

2. Color. MathType 5 lets you color all or part of an equation, or use multiple colors in a single 
equation. This is great for making captivating PowerPoint presentations or for printing color 
transparencies on an ink jet printer. Example: 

1 5 2 1 5 2 5 7Find the LCD: 
2 2 2 2x x x x x

+ = ⋅ + = + =
2 2x x

 

 
 

3. Web publishing. MathType lets you save your equations as GIFs to use in your web 
documents. MathType 5 can also generate MathML – an XML application that is the W3C 
standard for publishing mathematics on the web. 
 

4. Equation numbering. Not everyone needs to number equations or include references to 
equations in the text of a document. If you are a textbook author or write manuscripts for 
journal publication, you will appreciate the fact that MathType can number and reference 
your equations automatically when used with Microsoft Word. 
 

5. Precise formatting ruler. You get a sophisticated word processor-like ruler for 
precise formatting. Align columns at operators, decimal points; or set tab stops to 
make formatting easier and to give your documents a more professional look. This 
example cannot be duplicated exactly in Equation Editor for two reasons: cross-out 
templates, and ruler formatting (fractions aligned at right edge with a right-
justified tab).  

  
6. New spacing adjustments possible:  

• Radical “check mark” width adjustment:  2  2  2  
• Subscript and superscript horizontal gap:  

2x  
2x  

2x  
• Slash and diagonal fraction gap:  1

2  1
2  1

2  
• Horizontal gap between fence templates (parentheses, brackets, braces, etc.) and their 

contents:  ( )2 4x −  ( )2 4x −  ( )2 4x −  

• Stroke thickness for box lines, strike-throughs, radical signs, etc:  
1

2

2

2
⋅

2

 1

2

2

2
⋅

2

 1

2

2

2
⋅

2

 

1 2
2 23 3⋅ =

2
2
6

4
3 3
4 4

3
42

− −

Denominators in red. 
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1. Three drawings are shown. What would 

the next three look like? 
 
○ ○ ○ ○ ○ ○

○ ○ ○
○

 

 
2. Find the value of this expression:  

( ) ( )12 9 6 1− × +  
 

3. Compare. Use <, >, or = to complete the 
statement: 
 
a.  ( )5 3 1 5 3 1− × − ×  

b.  15 21
20 284 4  

 
4. Write a variable expression for this 

model. Squares represent ones; shaded 
rectangles represent variables:  

 

 
5. Add or subtract. Use models as needed. 

 

 
a.  7.1

0.8−
 

b.  1.2
0.91+

 

 
 

6. Find the areas of the two parts of the 
rectangle. Then find the total area of the 
rectangle. 
 

3

2 8
 

7. Find the quotient:  
?

24 120.60   
 

8. Find the sum:  3 4
_______10 5

+ =  

 
 

9. Write each ratio as a fraction in simplest 
form: 
 

 

a.  pencils : bells 
b.  stars : airplanes 
c.  bells : stars 
 

10. Stefan and Wanda played a game and completed 
the table below: 
 
Stefan wins |||| |||| |||| |||| |||| |
Wanda wins |||| |
Times played |||| |||| |||| |||| |||| |||| ||

 

 
a. Find Probability (Stefan wins) and  
 Probability (Wanda wins). 
 
   
 
   
 
 
b. Do you think the game is fair?  
 Explain.

Sixth Grade Examples 

Special symbols may be 
inserted into a matrix by 
finding the symbols with 
the Insert Symbol dialog 
(on the Edit menu). 

Cross-out templates are available in MathType 
but not Equation Editor. 
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